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ASTRONOMIYA KURSINI  AXBOROT TEXNOLOGIYALARI MUHITIDA 

О‘QITISHNING OʻZIGA XOS JIHATLARI 

 

Tillaboyev Azlarxon Magbarxonovich, 

Chirchiq davlat pedagogika universiteti Fizika kafedrasi mudiri, 

Pedagogika fanlari boʻyicha falsafa doktori (PhD) 

tillaboev.azlarkhon@mail.ru 

 

Ushbu maqolada astronomiya kursini  axborot texnologiyalari muhitida о‘qitish oʻziga xos jihatlari 

yoritilgan hamda hozirgi kunda axborot texnologiyalarining astronomiya kursini о‘qitishdagi ahamiyati 

ochib berilgan. 

Kalit soʻzlar: raqamli kameralar, kosmik observatoriya, Quyosh tojida yorug‘ nuqtasimon tuzilmalar, 

Quyosh yorug‘ rentgen nuqtalari, yarim о‘tkazgich fotodiod, fotoelektrik fotometrlar, raqamli texnika. 

 

ОСОБЕННОСТИ ПРЕПОДАВАНИЯ КУРСА АСТРОНОМИИ В СРЕДЕ 

ИНФОРМАЦИОННЫХ ТЕХНОЛОГИЙ 

 

В этой статье освещаются специфические аспекты преподавания курса астрономии в среде 

информационных технологий, а также раскрывается важность информационных технологий в 

преподавании курса астрономии в настоящее время. 

Ключевые слова: цифровые камеры, космическая обсерватория, светящиеся точечные 

структуры в солнечной короне, яркие рентгеновские точки, полупроводниковый фотодиод, 

фотоэлектрические фотометры, цифровое оборудование. 

 

FEATURES OF TEACHING AN ASTRONOMY COURSE IN AN INFORMATION 

TECHNOLOGY ENVIRONMENT 

 

This article highlights specific aspects of teaching an astronomy course in an information technology 

environment, and also reveals the importance of information technology in teaching an astronomy course 

today. 

Key words: digital cameras, space observatory, luminous point structures in the solar corona, bright 

X-ray points, semiconductor photodiode, photoelectric photometers, digital equipment. 

 

Kirish. Bugungi kunda zamonaviy axborot texnologiyalari hamda kosmik tadqiqotlarning kо‘pgina 

yutuqlari tufayli astronomiya tez rivojlanayotgan fanlardan biridir. Oxirgi 15-20 yil ichida teleskopsozlikda, 

nurlanish qabul qilgichlarni yasash sohasida katta yutuqlarga erishildi. Bu texnik taraqqiyot mahsulidir. 

Natijada astronomik bilimlar chuqurlashdi va kengaydi. Tekshirishlar davom etmoqda, astronomiyani 

qancha chuqur о‘rganganimiz sari yangi muammolar paydo bо‘lmoqda. Bularning hammasi astronomiya 

kursini har yili qayta qarab, yangiliklar bilan tо‘ldirib borishni taqozo etadi.  

Adabiyotlar tahlili va metodologiya. Zamonaviy teleskoplar yordamida olingan Quyosh aktivligiga 

tegishli tasvirlar koʻp olimlar tomonidan oʻrganilgan. Quyosh tojida yorug‘ nuqtasimon tuzilmalar, dastlab 

1969-yilda baland uchar raketalarga o‘rnatilgan yumshoq rentgen teleskopi (SXT-Soft X-ray Telescope) 

yordamida olingan Quyosh tasvirlarida kuzatilgan [1]. O‘lchami 4 dan 40 Mm gacha bo‘lgan shu’lalanuvchi 

bu tuzilmalar yorug‘ rentgen nuqtalari (YORN) deb ataladi, ularni 1973 yilda orbitaga chiqarilgan 

Skylab/AMP (AQSH) sun’iy yo‘ldoshiga o‘rnatilgan rentgen teleskopi va sakkizta raketa yordamida 

o‘rganishdi. “Golub” va boshqalar olingan materiallar asosida YORN soni Quyosh aktivligining asosiy 

ko‘rsatgichi bo‘lgan dog‘lar soniga teskari korrelyasiyada ekanligini topishdi [2]. To‘liq bo‘lmagan 

ma’lumotlar asosida olingan natija, 2002 yili Sattarov va boshqalar, tomonidan 1991-2001-yy. davri uchun 

yapon yo‘ldoshi Yohkoh (Solar-A) yordamida olingan muntazam kuzatish materiallari asosida tasdiqladi [3]. 

Shuningdek, YORNlarning ikki tipi aniqlandi: sokin va aktiv Quyosh yorug‘ rentgen nuqtalari. Bu natija 

2005 yili Mak-Intosh va Gurmanlar tomonidan tasdiqlandi [4]. Biroq ular YORN soni va quyosh dog‘lari 

orasidagi teskari korrelyasiyani topisholmadi. Mak-Intosh va Gurman, Xara va Nakakubolarning 

modifikatsiya metodini qo‘llashdi, ya’ni kuzatilyotgan teskari korrelyasiya Quyoshning aktivligi yuqori 

yillarida YORN ko‘rinishiga salbiy ta’sir qiluvchi ko‘rinma effekt deb hisoblashdi [5]. Keyinchalik Sattarov 

va boshqalar ko‘rinma effekt teskari korrelyasiyani to‘la tushuntirib beraolmasligini ko‘rsatib berishdi [6]. 

Shu bilan birga, teskari korrelyasiya har xil geliografik kengliklarda turlicha ekanligi topildi: teskari 
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korrelyasiya yuqori kengliklarda aniq namoyon bo‘lib, Quyosh ekvatori sohasida YORN soni kichik 

miqdorda oshishi kuzatiladi [7]. Bunday natijalarni olinishida albatta axborot texnologiyalarining oʻrni juda 

katta va bu oʻrganilgan yangiliklarni astronomiya kursi adabiyotlariga mavzular ketma-ketligida kiritish 

zarur. Shunda talabalar yangiliklardan bexabar qolmaydi. 

Astronomik ta’lim, axborot texnologiyalariga muhtoj soha bо‘lib, buning bir nechta obyektiv va 

subyektiv jihatlari mavjud, bular: 

- talabalar oddiy, kundalik hayotda kuzatmaydigan yoki kuzatsa ham shu darajada sekin va muntazam 

rо‘y beradigan jarayon va hodisalarki, ularga talaba e’tiborini qaratish va fikrini ushlab turish qiyinligi; 

- osmon yoritqichlarining yorug‘ligini fotoelektrik fotometrlar (elektron optik kо‘paytgichlar) 

yordamida о‘lchash imkonining yuzaga kelganligi; 

- kosmik tadqiqotlarning shiddat bilan rivojlanishi hamda bunday tekshiruvlarda raqamli texnikaning 

qо‘llanilishi; 

- raqamli kameralarning eng yaxshi sifatlari (axboriylik va yuqori aniqlik)ni о‘zida 

mujassamlashtirgan bо‘lib, samaradorlik va aniqlik (sifati)ni  о‘n va hatto yuz martaga oshirishi; 

- hozirgi zamon astronomik kuzatish-tekshirish ishlari tо‘liq axborot texnologiyalari muhitida 

bajarilishi; 

- bugungi kunning kosmik teleskoplari tо‘plagan ma’lumotlar  internet axborot banklarida 

saqlanishining yо‘lga qо‘yilganligi; 

va nihoyat oddiy ta’lim muassasasi sharoitida shular kabi barcha astronomik kuzatish-tekshirish  

ishlarini bajarib bо‘lmasligidir. 

Shuning uchun astronomiyani an’anaviy holda о‘qitishdan kо‘ra  axborot texnologiyalari muhitida 

о‘qitish yaxshi samara beradi.   

Masalan, yulduzlar  osmonining  sutkaviy va yillik  aylanishini va osmon sferasi tо‘g‘risidagi 

tushunchalarni olaylik. Sutkaviy aylanishni sayyoralarda namoyish etiladi, bu talabalarni darsdan tashqari 

paytda, о‘quv masqanidan chetga olib chiqishni  taqozo  etadi va bunday  ekskursiyalarni butun  kurs  

davomida  bir  marta, kо‘pi  bilan ikki marta uyushtirish mumkin. О‘qitish jarayonida bu yetarli emas [8].  

Axborot - kommunikatsiya  texnologiyalari,  dastavval  kosmonavtika va kosmik tadqiqotlarda 

shakllandi, о‘z tadbig‘ini topdi va rivojlandi. Bu tadqiqotlarning aksariyati osmon jismlarini, ularning yaqin 

atrofidan о‘tayotib rasmga olish (Merkuriy, Mars, Yupiter, Saturn va boshqalar) yoki sirtiga avtomatik 

apparatlar tushirish  jarayonida,  ularning atmosferasini (Venera, Mars) va sirtini (Oy) tekshirish bilan 

bog‘liq. Bunda, olingan natijalar (axborotlar)ni Yerga yuborish va tahlil qilish kabi masalalar, axborot 

texnologiyalarini astronomiyaga qо‘llashga  asos bо‘ldi [9].  

Kosmik tadqiqotlarni rivojlanishi, raqamli texnikani qо‘llashga undadi. Dastavval kosmik 

observatoriyalar uchun ishlab chiqilgan va qо‘llanilgan telemetrik asboblar, raqamli kameralar Yerdagi 

observatoriyalarda ham keng qо‘llanila boshlandi. Bunday raqamli kameralarga о‘xshash asboblar  hozirgi  

kunga kelib, kundalik hayotda (raqamli fotoapparat, videokamera) ham keng qо‘llanilmoqda. 

Dastavval, raqamli  kameralarni  qо‘llashdan  oldin,  an’ana bо‘yicha, astronomik kuzatish-tekshirish 

ishlari osmon yoritqichlarini surat (fotoplastinka yoki plyonka)ga tushirish va suratlarda yoritqich (yulduz) 

tasviri fotografik zichligini о‘lchash orqali uning yorug‘ligi о‘lchanib, kuzatish tekshirish jarayoni ikki 

bosqichga amalga oshirilar edi. Bunday usul bitta muhim  afzallikka ega: uning yordamida   Yer  sirtidan  

turib  osmonning keng yuzasi suratini olish mumkin. Bunday suratda yuzdan ortiq yulduzlarning tasviri 

olinadi va laboratoriya sharoitida bu yulduzlar yorug‘ligini о‘lchash ishlari olib boriladi. Biroq, bunday 

о‘lchashlarning xatosi 10-20 % gacha yetadi, bu esa juda katta xatolik.  

Keyinchalik, osmon yoritqichlarining yorug‘ligini fotoelektrik fotometrlar (elektron optik 

kо‘paytgichlar) yordamida о‘lchash imkoni yaratildi. Bunday о‘lchashlarning  hatosi  fotografik  usulnikidan 

10 marta kichik  bо‘lsada, ularni har bir  yulduzga  nisbatan  qо‘llash  taqozo etiladi. Bitta  yulduz  

yorug‘ligini о‘lchash uchun  bir  necha soat vaqt ketadi va mingdan ortiq yulduzlar yorug‘ligini о‘lchashni 

kо‘p yillarga chо‘zib yuboradi. 

Natija. Raqamli  kameralar yuqorida qayd qilingan ikkala usullarning eng yaxshi sifatlari (axboriylik 

va yuqori aniqlik)ni о‘zida mujassamlashtirgan bо‘lib, samaradorlik va aniqlik (sifatni)ni  о‘n va hatto yuz 

martaga oshiradi. Raqamli kamerada uning fokal tekisligiga, fotoplyonka о‘rnatiladigan joyga, tomonlari bir 

santimetr bо‘lgan tо‘trburchak shisha yuziga 512x512 yoki 1024x1024 ta nur sezuvchi yarim о‘tkazgich 

fotodiod joylashtirilgan chip о‘rnatilgan bо‘ladi. Fotodiodlarning о‘lchami bir necha mikronga teng va unga 

nur tushganda u kondensator singari zaryadlanib qoladi. Maxsus zaryad sanoqchi yordamida bu zaryadlar 

sanaladi va elektron disklarga yozib olinadi. Bunday elektron disklarda yozilgan raqamli tasvirni kompyuter 

ma’lum dastur asosida ekranda namoyish etadi. Bugungi kunda sirti kо‘rinadigan osmon jismlarining 

(sayyoralar, tumanliklar, galaktikalar) nihoyatda aniq tasvirlari olinmoqda. Astronomik kuzatish–tekshirish 
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ishlari nihoyatda yuqori bosqichga kо‘tarildi. Bunday tasvirlarni kompyuter orqali kuzatish va ularni 

qog‘ozga chiqarish mumkin. 

Yuz yildan ortiq vaqt davomida qо‘llanib kelingan fotografik tekshirish usuli (fotoplastinkaga rasmga 

olish va uni keyin о‘lchash) о‘rnini raqamli kameralar va ularga ulangan kompyuterlar egalladi. Osmon 

jismlari tasviri raqamli kameralar va «signal-raqam» almashtirgichlar yordamida kompyuter о‘qishi va 

qayta-ishlay oladigan ikki  о‘lchamli  raqamli massiv sifatida kompyuter xotirasiga, magnit tasma yoki 

disklarga yozib olish mumkin.  

Hozirgi zamon astronomik kuzatish-tekshirish ishlari tо‘liq axborot texnologiyalari muhitida 

bajariladi. Avtomatik kosmik apparatlarda sinovdan о‘tgan, masofadan turib teleskop (masalan, Xabbl 

Kosmik Teleskopi)ni boshqarish tizimi Yerdagi  teleskoplarda ham qо‘llanilmoqda. Astronom olim teleskop 

yonida turishiga va uni boshqarishiga zarurat yо‘qoldi. Teleskop va unga о‘rnatilgan о‘lchash asboblarini 

ulardan masofada (xatto, boshqa shaharda, qit’ada) bо‘lgan astronom kompyuter ekranida kuzatib turadi va u 

telekommunikatsiya aloqa vositalari yordamida kuzatishni nazorat qiladi va boshqaradi. Kuzatish-о‘lchash 

natijalari shu astronom-kuzatuvchining kompyuteri xotirasiga tushadi. 

Oxirgi yillarda astronomik kuzatish-о‘lchash ishlariga raqamli kameralar tatbiq etilmoqda. Ular 

astronomik о‘lchashlarni raqamli tizimga о‘tkazishga va ularga hisoblash texnikasini qо‘llashga imkon berdi. 

Natijada, astronomik kuzatish natijalari magnit disklarda tо‘plana boshlandi. Astronomik о‘lchash natijalari  

saqlanadigan  internet  banklar hosil bо‘ldi va ularda tо‘plangan ma’lumotlar  keng  ilmiy jamoatchilik uchun 

ochiq deb e’lon qilindi. Bunday sharoitda internet nihoyatda katta xizmat kо‘rsatmoqda.  

Kosmik va radioteleskoplar hozirgi zamon astronomiyasiga elektromagnit tо‘lqinlar shkalasining 

barcha qismlarida kuzatish-о‘lchash va tekshirish ishlari bajarish imkoniyatini berdi. Optik diapazondan 

tashqarida joylashgan bu diapazonlarda bajarilayotgan ushbu qimmatbaho tekshirishlar nafaqat pedagogik 

ta’lim muassasalari uchun, balki, akademik ilmiy tekshirish institutlari uchun ham katta muammoli 

masaladir. Yuqorida tilga olingan kompyuterda bajariladigan laboratoriya ishlari orasida kvazarlar 

(yulduzsimon radionurlanish manbalari)ni tekshirishga bag‘ishlangan va radiolokatsiya qilish usuli bilan 

Merkuriyning о‘q atrofida aylanishini о‘lchaydigan  ishlar kiritilgan. Bulardan tashqari Quyoshning rentgen 

va chetki ultrabinafsha nurda olingan rasmlarida Quyosh tojini kuzatish va tekshirish mumkin. Masalan 

quyidagi laboratoriya ishini koʻrib chiqaylik. 

Koinotning katta о‘lchamli tuzilishi 

Ishning maqsadi: galaktikalar spektridagi chiziqlarning qizilga siljishiga ko‘ra aniqlangan tezlikni 

masofaga bog‘liqligini tushuntirish va galaktikalarning Koinotda taqsimlanish modelini chizish. 

Kerakli jihoz va qo‘llanmalar: Windows 7-11 (64-bit) kompyuter, VIREO (Virtual o‘quv 

observatoriyasi) dasturi. 

Nazariy ma’lumotlar 

Koinotning bizga ko‘rinadigan qismi Metagalaktika deb ataladi. Metagalaktika milliardlab 

galaktikalar, kvazarlardan tarkib topgan. Hozirgi zamon kuzatish vositalari yordamida qayd qilingan eng 

uzoq obyekt (kvazar) larning masofasi Metagalaktikaning radiusi deb qabul qilingan va u 4000 Mpk 

(megaparsek)dan biroz ko‘proq. Bu o‘lcham Xabbl qonuniga galaktikalarni qochish tezligi o‘rniga kvazarlar 

tezligi (270000 km/s)ni va Xabbl doimiysi H=73 km/sMps qiymati asosida topilgan. Metagalaktikadagi 

obyektlar har xil yo‘nalishlar va masofalar bo‘yicha o‘rtacha olganda bir tekis joylashganlar. O‘rtacha bir 

jinsli deganda biz Metagalaktikani katta o‘lchamli (1000 Mpk) tuzilishni nazarda tutmoqdamiz. Yuqorida 

ko‘rganimizdek kichik o‘lchamli (100 Mpk) qismlarida Metagalaktika bir jinsli emas, unda galaktikalar 

guruhlari, to‘dalari, o‘ta katta to‘dalar kuzatiladi. Metagalaktikani katta o‘lchamlarda bir jinsliligi undan 

tashqarida ham o‘rinli bo‘lsa kerak deb faraz qilish mumkin. Shunday qilib butun Koinot (ya’ni 

Metagalaktika va undan tashqaridagi koinot qismi) da materiya izotrop va bir jinsli taqsimlangan deb qarash 

mumkin. 

Har xil uzoqlikda joylashgan Koinot obyektlaridan kelayotgan va qayd qilinayotgan nurlanish ulardan 

har xil vaqtlarda sochilgan. Yorug‘likning tarqalishi tezligi fundamental fizik doimiyligini hisobga olsak 

uzoqda joylashgan kvazarlardan kelayotgan nurlanish yaqindagi galaktika (Andromeda tumanligi) dan 

kelayotganlarga qaraganda ancha (10 mld. yil) oldin sochilgan (yo‘lga chiqqan). Metagalaktikada uzoqlik 

bo‘yicha obyektlar (galaktikalar)ni taqsimlanishidagi bir jinslilik ular hosil bo‘lish vaqti bo‘yicha uzluksiz 

ketma-ketlikni hosil qiladi degan xulosaga olib keladi. 

Galaktikalar va kvazarlar spektrida chiziqlarni qizilga siljishi ularni bizdan uzoqlashish bilan 

tushuntiriladi. Obyekt bizdan qancha uzoqda bo‘lsa uni uzoqlashish tezligi shuncha katta. Metagalaktika 

kengaymoqda, kengayish tezligi Xabbl qonuni  bilan ifodalanadi. Metagalaktikani tashqi chegarasi 

yaqinida kengayish tezligi yorug‘lik tezligiga yaqinlashadi. Agar bu qonuniyat Metagalaktikadan tashqarida 

ham o‘rinli deb hisoblasak u holda bir jinsli butun Koinot hozirda kengaymoqda. Demak u o‘tgan 
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zamonlarda hozirgiga qaraganda zichroq va qaynoqroq bo‘lgan va uzoq o‘tmish (10 mld. yil oldin) esa 

zichlik va temperatura juda yuqori bo‘lgan. Metagalaktikada kuzatilayotgan obyektlar va jarayonlar butun 

olamni tortishish qonuni (umumiy nisbiylik nazariyasi)ga bo‘ysunadi. Bu qonunni uzoq o‘tmishdagi o‘ta 

yuqori zichlik (1093g/m3) va temperaturadagi (1032 K) Koinotga tadbiq etib bo‘ladimi, yo‘qmi bu muammo 

bo‘lib qolmoqda. 

Ishni bajarish tartibi 

Kompyuterga VIREO dasturi o‘rnatiladi va dastur ishga tushiriladi. VIREO dasturi (I) ishchi oynasi 

ochilgach, uning tepa chap chetida «File» yozuvi ustiga Kursorni qo‘yib bir marta bosing, hosil bo‘lgan 

ustundan «Login» ni bosing (1-rasm, tepa chapda). Ishchi oynada «Student Accounting» sahifasi ochiladi 

(1-rasm, o‘ngda). 

 Unga talabalarning ismini va laboratoriya ishi raqamini (Laboratory Table Number:) kiriting va 

«Ok» ni bosing, yangi sahifa chiqadi, unda tepa chap chetidagi «File» yozuvi ustiga kursorni qo‘yib bir 

marta bosing, hosil bo‘lgan ustundan «Run Exercise…» yozuvi ustiga kursorni to‘g‘irlang, hosil bo‘lgan 

ustundan «The Large Scale Structure of The Universe» nomli yozuv ustiga kursorni bir marta bosib yangi 

sahifani ochamiz (1-rasm, pastda). 

 

 
1-rasm 

 

Teleskopni ishga tushirish 

Yangi ochilgan (II) sahifa tepasidan «Telescopes» yozuvi ustiga kursorni to‘g‘rilab bir marta bosing, 

unda “Optical” yozuvi hosil bo‘ladi. Kursorni “Optical” yozuvi ustiga qo‘ying va hosil bo‘lgan ustunda 

“Access 4 Meter” bosing (bu amalni bajarishda 1 m yoki 4 m li teleskopdan foydalaniladi). Endi “Open” 

tugmasini bosing, observatoriya oynasi ochilgach “off” tugmasini bosib teleskop (III) sahifasi ochiladi.  
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2-rasm 

Osmon sahnida yoritkichlar va qizil kvadrat bor, e’tibor bersangiz yoritkichlar chapdan o‘ngga tomon 

siljimoqda, bu osmonning qo‘zg‘almas teleskopga nisbatan sutkaviy aylanishidir, bu harakatni to‘xtatish 

uchun «Tracking» ni bosing. Endigi qiladigan ishimiz kerakli obyektlarni tanlash bo‘ladi. Buning uchun 

“Slew” menyusidan “Observation Hot List”  “Load Hot List…” amalni bajarib “Select LSS Field” 

oynasi ochiladi va ro‘yhatdan “Survey Field 1” ustiga kursor bilan tez-tez ikki marta bosing (bunda birinchi 

maydon obyektlari ro‘yhati ochiladi) (2-rasm, tepa chapda), keyin “Slew” menyusidan “Observation Hot 

List”  “View/Select ….” Amalini bajarib galaktikalar ro‘yxatini ochamiz (2-rasm, tepa o‘ngda). Ochilgan 

ro‘yxatdan birinchi galaktika ustiga Kursorni ketma-ket ikki marta bosilsa galaktika koordinatalari chiqadi 

(2-rasm, past chapda), “OK” tugmasini bosib teleskopni bu obyektga to‘g‘irlaymiz. Teleskop kerakli 

obyektga to‘g‘irlangandan keyin “View” ustunidan “Telescops” yozuviga bosing. 

Kuzatuv oynasi o‘rtasida ikkita parallel qizil kesmachalar paydo bo‘ladi (2-rasm, past o‘ngda). Agar 

parallel qizil chiziqlar galaktikani ustida bo‘lmasa N, S, E, W tugmalar yordamida tanlangan galaktikani 

tirqish ichiga joylashtiramiz. 

Spektrometr yordamida galaktika spetrini aniqlash 

Galaktika spetrini aniqlash uchun “Telekop boshqaruv paneli (II sahifa)” dan  “Instrument” ustuni 

pastidagi «Access» nomli tugmani bosamiz va “VIREO Reticon spectrometer Reading” nomli yangi (IV) 

sahifa ochiladi. Sahifa o‘rtasida koordinata o‘qlari belgilangan grafik chizish uchun tayyor chizma 

joylashtirilgan. Endi «Go» tugmasining ustiga kursorni qo‘yib bosing. Chizma ichida spektrometr qabul 

qilayotgan fotonlar orqali galaktika spektri shakllana boshlaydi. Fotodiodlar tushayotgan fotonlar oqimi 

o‘zgaruvchan bo‘lganligi uchun qancha uzoq vaqt davomida foton sanalsa har bir fotodiodga tushayotgan 

fotonlar yig‘indisi shu to‘lqin uzunlikda kelayotgan oqimning haqiqiy qiymatiga yaqinlasha boradi, 

spektrning yozuvi silliq egri chiziqga aylanaboshlaydi. Chizmadan pastda galaktikaning belgisi «Object» 

to‘g‘risida, ko‘rinma kattaligi «App. Mag (V)» ko‘rinib turadi. Foton yig‘ish vaqti «Integration» 

(sekundlarda), o‘rtacha har bir fotodiodda to‘plangan fotonlar soni «Photons per Channel» va 

signal/shovqin nisbati «Signal/Noise» to‘g‘risida yozila boshlaydi (3-rasm, chapda). 
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3-rasm 

«Signal/Noise» nisbati 100 dan ortishini kutib, foton sanashni davom ettiramiz. Bu nisbat 1000 ga 

yaqinlashganda spektr juda yuqori sifatli bo‘lib chiqadi. «Signal/Noise» nisbat 100 dan oshgandan keyin 

«Stop» ni bosish mumkin. Shunda sanash to‘xtaydi va o‘lchash natijalarini kompyuter xotirasiga yozib 

qo‘yish kerak, buning uchun sahifa tepasidagi “File” ga kirib “Data” yozuvi ustiga kusorni to‘g‘irlang, 

hosilbo‘gan ustundan  «Save Spectrum» ni bosing. Bunda olingan spektr boshida talaba nomiga ochilgan 

papka ichiga obyekt nomi (...CSP) bilan saqlandi (3-rasm, o‘ngda). Endi uchinchi (III) sahifaga qaytamiz va 

har bir maydondagi galaktikalarning spektrini aniqlab olamiz. 

Galaktikalar spektrining qizilga siljishi aniqlash 

Galaktikalar spektridagi qizilga siljishni aniqlash uchun osmon sahnini berkitib (I) asosiy sahifaga 

qaytamiz. Bu sahifaning chap yuqori qismidagi “Tools” → “Spectrum Measuring” dan “VIREO Spectrum 

Measuring Engine” sahifasi ochiladi. Sahifaning chap yuqori burchagidagi “File”→“Data”→“Load Saved 

Spektrum” amali bajariladi. Bunda yuqorida saqlangan spektrlar papka ko‘rsatiladi. Ulardan ketma-ketlikda 

tanlab ochamiz (4-rasm). 

 
4-rasm 

Ochilgan papka ichida biz olgan spektr chiqadi. Bu sahifada “Comparision Spectrum” → “Select” 

amalini bajarish orqali  “Line for Z Measurement” sahifasi ochiladi (5-rasm, tepa chapda). Bu sahifadan 

“Absorbtion Line in normal galactics (H, K, and G band)” ustiga kursor bilan tez-tez ikki marta bosish 

orqali ochilgan galktika spektrida H, K va G chiziqlarining o‘rnini ko‘rsatuvchi vertikal chiziqlar paydo 

bo‘ladi (5-rasm, tepa o‘ngda). 
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5-rasm 

O‘lchash natijalari o‘rtachalanib, egri chiziq bilan tutashtiriladi va spektrni yozuvi hosil bo‘ladi. Bu 

yozuvda qora chiziqlar intensivlikni keskin pasayib va yana keskin ko‘tarilishi sifatida namoyon bo‘ladi va 

galaktika tutash spektrida chuqurcha shakliga ega bo‘lgan K(CaII) 3933,7 Ao, H(CaII) 3968,5 Ao va 

G(metall tasma 4305 Ao) yutilish chiziqlari ko‘ranadi. H, K va G chiziqlarini eng intensivligi pas bo‘lgan 

chuqurchalarga to‘g‘irlash uchun pastdagi suriluvchi tugma yordamida o‘ngga tomon surib to‘g‘irlanadi (5-

rasm, past chapda). Agar surish tugmasi o‘ng chegaraga yetsa, biroq vertikal chiziqlar spektral chiziqlar 

o‘rtasiga tushmasa, surish tugmasi ustidagi katakdagi tugmani “Coarse” ga qo‘yish orqali muammoni hal 

qilsa bo‘ladi. Vertikal chiziqlar spektral chiziqning qoq o‘rtasida bo‘lgan holga mos keladigan “Z” suriluvchi 

tugma yacheykasiga yozib olinadi (5-rasm, past o‘ngda). Bu yozuv butun va kasr qismdan iborat, uning o‘ng 

tomonida yozuvdagi sonni yana o‘n darajasi minus songa ko‘paytirish zarur. Keyingi qiladigan ishimiz har 

bir spektral chiziq (H, K, G) uchun to‘lqin uzunligini yozib olishdir. Buning uchun vertikal chiziqlar ustiga 

kursorni to‘g‘rilab bir marta bosilganda qizil chiziq oq rangga o‘tadi, shu holatdagi “wavelength” 

yacheykasidagi son qiymat shu spektr to‘lqin uzunligini bildiradi va yozib olinadi. 

Aniqlangan qizilga siljish qiymatidan foydalanib galaktikalaning nuriy tezligi topiladi. Endigi 

qiladigan ish, “File”→“Data”→“Record Measurements…” amalini bajarib olingan natijani saqlash 

bo‘ladi. Saqlash vaqtida “Measured Redshift…” sahifasi opchiladi. Bu sahifada “Velocity” (tezlik) 

yachaykasiga yuqorida topilgan nuriy tezlik qiymatini yozamiz va “Ok” tugmasini bosib natijani saqlaymiz. 

Har bir galaktika spektridan yuqoridagi amallarni bajarib qizilga siljishni va tezlik qiymatlarini topib savlash 

amallarini bajaramiz.  
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6-rasm 

Koinotning katta o‘lchamli tuzilishi 

Galaktikalar spektrida chiziqlar K(CaII) 3933,7 Ao, H(CaII) 3968,5 Ao va G(metall chiziqlari) 4305 Ao 

ni siljishidan topilgan, ularning uzoqligi va o‘lchangan koordinatalari (α va δ) ga asosan ularni fazoda 

joylashishi o‘rgniladi. 

Galaktikalar spektrida chiziqlar to‘lqin uzunligi (λ) o‘lchangandan keyin bu chiziqlarning qizilga 

siljishi ( , - qo‘zg‘almas manba spektrida chiziqning to‘lqin uzunligi) va unga asoslanib 

galaktikaning nuriy tezligi  hisoblanadi. Maydonlardagi barcha galaktikalarning tezligi o‘lchangach 

(α, δ, υ) diagrammasi tuziladi(7-rasm). Diagrammani tuzish uchun olindin har bir spektrdagi tezliklar 

yuqorida aytilganiday saqlangan bo‘lishi kerak. Endi saqlangan natijalar asosida asosiy sahifa(The Large 

Scale Structure of The Universe)ga qaytamiz va “Tools” → “LSS Wedge Plot” amalini bajaramiz. Sizda 

kerakli diagramma hosil bo‘ladi. Bu diagrammada siz spektrini o‘rganish orqali topgan tezlik va 

koordinatalar bo‘g‘lanishi kelib chiqadi. Bu galaktikalarning Koinotdagi taqsimotini ko‘lsatadi. “File” → 

“Print Wedge Plot…” amalini bajarish orqali diagrammani saqlash yoki printerdan chiqarish mumkin. 

 
7-rasm 

Vazifa 

1. Berilgan maydonlardagi galaktikalarning spektrini oling va har bir chiziq uchun ularning to‘lqin 

uzunliklari, qiziliga siljish va nuriy tezliklarini aniqlang. 

2. Yuqoridagi ma’lumotlardan foydalanib Koinotning katta o‘lchamli strukturasi diagrammasini 

tuzing. 
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Bunday laboratoriya ishlarini bajarish talabaning nafqat bilim, koʻnikma va malakalarini 

rivojlantirishga balki ularni tadqiqotchilik koʻnikmalarini rivojlantirishga ham xizmat qiladi. 

Muhokama. Astronomik kuzatishlar turli kо‘rinishlarda bо‘lib, ularning ayrimlari osmon 

yoritkichlarining koordinatalarini aniqlash bilan bog‘liq bо‘lsa, boshqalari yoritkichlarning yorug‘ligini 

о‘lchashni kо‘zda tutadi. Uchinchilari esa yoritkich spektrini olishni va о‘lchashni  taqozo  etadi. Yana bir 

turi kosmik stansiya yordamida yoritqich  spektrining rentgen, uzoq ultrabinafsha qismida о‘lchashlar bilan 

bog‘liq.  

Oddiy ta’lim muassasi  sharoitida bunday ishlarni bajarib bо‘lmaydi. Bunday sharoitda internet 

tizimidan foydalanish, astronomik internet banklardan olingan kerakli  kuzatish  natijalari  astronomiyani 

о‘qitishda, kuzatish va laboratoriya ishlarini  bajarishda  katta  samara beradi va hozirgi zamon talablariga 

javob beradigan mutaxassislar tayyorlashda muhim ahamiyat kasb etadi.  

Masalan, Xabbl Kosmik Teleskopi tо‘plagan ma’lumotlar Kosmik Teleskop Institutida (HST), Quyosh 

va geliosferik observatoriya (SOHO - Solar and Heliospheric Observatory, u Yerdan bir million kilometr 

uzoqlikda, Quyosh-Yer tizimining birinchi Lagranj nuqtasiga joylashtirilgan) nomli apparat yordamida 

olinayotgan Quyoshning rentgen, ul’trabinafsha nurlardagi tasvirlari, magnitogrammalari va 

dopplerogrammalari Goddard va Marshall uchish markazlarida tо‘plangan, ularni ushbu 

http://umbrawww.nascom.nasa.gov internet sahifadan olish mumkin. Bu materiallar asosida astronomiya 

о‘qituvchilari uchun kо‘rgazmaviy qurollar va filmlar tayyorlanmoqda. 

Xulosa. Yuqorida  qayd  qilingan  internet  sahifasida yerdan turib va kosmosdan olingan Quyoshning 

tasvirlari bilan birgalikda, Quyoshning Yerga ta’sirini tekshirishdan olinayotgan kо‘plab ma’lumotlar 

joylashtirilgan. Bu internet sahifa ulkan axborot maydonidir. Bugungi kunda bunday axborot maydonlari 

kо‘paygan bо‘lib, ulardan astronomik bilimlarni berishda keng foydalanilsa, yuqori darajadagi ta’lim  

samaradorligini oshirishga erishish mumkin. Nafaqat ta’lim samaradorligini oshirishga balki talabalani 

astronomiya sohasi boʻyicha ilmiy tadqiqot ishlariga boʻlgan qiziqishlarini oshirishga ham erishish mumkin. 
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